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PROJECT OVERVIEW 
 

The West Virginia GIS Technical Center is working with the West Virginia Department of 

Transportation (DOT) to scan large format highway plan sheets into digital raster images. For 

every highway plan book, a single Adobe PDF file of all the sheets is created along with an 

index map that is spatially referenced. The WV Division of Highways Plan Scanning Project is 

fulfilled through a series of steps and processes that are described throughout this 

documentation. Records are kept to document time spent on each process and are used to 

calculate estimations of time and cost for future evaluation. Technicians are expected to keep 

accurate records of time spent on each process and record their activity in the DOT_Operator 

access table.  

 

SEVEN MAJOR PROCEDURAL TASKS:  

 

The scanning project consists of seven major work tasks which are described in more detail 

below.  

 

(1) Book Preparation and File Naming:  Once the Tech Center receives a batch of project 

books from the DOT, book preparation can begin. This process consists of placing each book in 

the designated location in the Tech Center, and should be kept separate from books that have 

been completed or ones that are file-named and still in progress.  

Every WV DOT project book scanned by the WVGISTC will have an entry in the WV DOT 

Scanning (dbo_Scanning) Database.  This database consists of key transportation fields for 

identifying the highway book, unique scan order and project key identifiers, scan information for 

tracking projegress and work tasks, index map coordinates, and useful online links for the PDF 

Book, geographic location, ProjectWise location, etc.    

After they are placed in their appropriate location, the technician will select a project book and 

enter description information about the plan book in the dbo_Scanning table.  Each DOT project 

book gets an entry in this table, which should be filled out at the time the project book is 

scanned.   

This consists of recording the information on the transmittal sheet (found inside the map 

(folder/rolled map)) and the Project Book cover sheet. Once all information is documented, the 

technician will then create and record a Scan Order Number on the transmittal sheet and 

relocate the book and transmittal to the location designated for the file named documents that 

are to be scanned.  

 

(2) Sheet Scanning: The technician will begin this process by selecting a book from the file-

named books area and bringing it to the scanner workstation. The scanner must be set to 

specific settings before the book can be scanned, which ensures that the image is in the proper 

format and is named correctly.  Additionally, a new folder at the scanner workstation must be 

created and should be named according to the Scan Order Number on the transmittal sheet.  

After these are completed, the first book document is to be wiped off with the cleaning products 
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provided to protect the scanners from dirt and any potentially damaging debris. If the technician 

finds that the project book is especially dirty or is in bad condition, document protectors can be 

used. These are found on the bottom shelf of the filling cabinet work table. Once the technician 

is sure that the document is clean and the file location and scanner settings are correct, the 

document can be scanned.  After the entire book is scanned, the file must be moved from the 

local workstation, to the IncompleteBooks folder on the RDrive.  The physical project book 

should then be noted that it has been scanned and then placed in designated location. It is 

important to be sure that all Scanner components are maintained and kept clean.  

 

(3) Image Processing: This action utilizes tools (or droplets) created in Photoshop to make 

image adjustments and crop automations, and can be found in the scripts folder of 

wvDOT_planROW_scanning. Dragging the tiffs created in the scanning process and dropping 

them into the autocrop droplet will begin the operation. Once the operation has finished, check 

each image and crop by manually when necessary.   

 

(4) PDF Creation:  After image processing has been completed, the edited tiffs are to be 

compiled into a PDF document. To do this, an “action” needs to be created in Adobe Acrobate 

Pro to reduce file size and recognize text (using ORC). This action is found in the scripts folder 

of wvDOT_planROW_scanning. After this is completed, the PDF is relocated to the PDF folder 

created on the technicians’ local work station. The document must then be checked and 

corrected for any rotation or other errors. Once the PDF is correct, rename the document using 

the Scanning ID Number. 

 

(5) Georeference Plan Index Map:  The technician will use Photoshop, Google Maps, and 

ArcGIS to locate and georeference each project book. The target object to be georeferenced is 

typically found on the first page and is contained in the index map, but it can be found in various 

places throughout the project book. The page that contains the object to be georeferenced must 

be copied from the tiff folder and then pasted into the GeoTiff folder. Once it is in the proper 

location, the technician must open the tiff and apply the levels droplet. This droplet ensures that 

the image is in the appropriate format and prepares it to be georeferenced on ArcMAP.  After 

this is complete, the object’s location needs to be found on the map. By using spatial 

information found throughout the ProjectBook, the technician can find the location with Google 

Maps and ArcMap. Once identified, the image is to be georeferenced based off of at least three 

(3) control points set by the technician.  The georeferenced image will then need to be named 

according to the DOT naming conventions.  The GeoTiff folder is to be relocated from the local 

workstation to the book’s file in incomplete books (R-Drive). Lastly, the technician must update 

the GeoTiff page number on dbo_Scanning in Access.  

 

(6) Quality Control & File Renaming: Due to the complexity in the several previous processes, 

a special emphasis is placed on quality control and assurance to confirm that the technicians 

are providing the best possible product. The technician will check for accuracy and completion 

of the Database entry, file-name, image processing, PDF, and GeoTiff. Upon completion, the 

technician will use the file renaming tool to rename the quality assured folder in the 

IncompleteBooks folder. Once renamed, it will be moved to the Projectbooks folder.  It is 

recommended that technicians do not Quality Control their own work.  
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(7) Publishing to Web Map:  The final process to the WV Division of Highways Plan Scanning 

Project is uploading the tiffs, PDF, and GeoTiffs to the website. First, the PublishGeoTiff.pyt 

script will run python to copy and replace GeoTiff’s into a new folder that will be used to add 

scan rasters to the mosaic.  Once relocated into a new folder and added to the mosaic, the 

technician will use the DOTFootprints.pyt tool to create footprints of the georeferenced image 

(corners of the image). Next, the footprint extents need to be copied into the dbo_Scanning 

table. This is done with the UpdateFootprintextents tool in ArcMap and will automatically update 

X and Y Min/Max fields in the dbo_scanning table. After this tool is finished, the technician must 

update the PublicationStatusID column in dbo_Scanning, which will publish the projectbook to 

the images in the ArcGIS Online Map.  
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HIGHWAY PLAN TYPES 

 

Various types of highway plans are scanned, processed, and published by technicians.  The 

bridge and ROW plans are of the highest priority to scan. 

 

Table 1:  Descriptions of various types of highway plans. 

Plan Type Code Description 

ROW Plans R 

Right of way plans show the land obtained by WV DOT to complete 
highway projects.  The right of way portion of the plan set is used to 
convey information about the right of way boundaries and adjacent 
property lines, the property ownerships and acreage involved in the 
takes and the overall impact the improvement will have to the 
particular property owners. Appraisers, negotiators and attorneys all 
use the right of way plans to assist them with their work when 
determining fair market value, negotiating with the property owner or 
explaining a condemnation case to a jury. 

Bridge Plans B 
Bridge plans show construction and location of a specifics of a bridge 
(e.g., type of girders, type of span, soils). 

Construction 
Design Plans 

P 

The construction portion of the plan set is used to convey information 
about the design of the roadway itself, the amount and type of 
construction materials used for the project and the types of 
construction methods used to complete the work. Designers, 
estimators and construction workers all use the construction plans to 
assist them with their work when determining current standards, 
estimating the cost of the project or constructing the improvement. 
Important for maintenance of existing highways.  The construction 
plans are important for maintaining current highways such as re-
pavement projects.  The bridge and shop drawings are tied to the 
planning sheets. 

Shop 
Drawings 

S 

Shows the way materials were fabricated.  A shop drawing is a 
drawing or set of drawings produced by the contractor, supplier, 
manufacturer, subcontractor, or fabricator.  Shop drawings are 
typically required for prefabricated components such as the structural 
steel, trusses, etc. 

Half-Sized 
Plans 

H 
Half-sized plans show exactly what the contractors were told to build 
or as plans were let to the contractors. 

As Built A 

Revised set of drawing submitted by a contractor upon completion of 
a project or a particular job. They reflect all changes made in the 
specifications and working drawings during the construction process, 
and show the exact dimensions, geometry, and location of all 
elements of the work completed under the contract. Also called 
record drawings or just as-builts.  Typically the as-built plans located 
in  the District Offices and not kept in a consistent and orderly 
manner. 
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(1)  BOOK PREPARATION & FILE NAMING 
 

Once the Tech Center receives a batch of project books from the DOT, book preparation can 

begin. This process consists of placing each book in the designated location in the Tech Center, 

and should be kept separate from books that have been completed or ones that are file-named 

and still in progress. After they are placed in their appropriate location, the technician will select 

a project book and create and name the book in the dbo_Scanning table.  This consists of 

recording the information on the transmittal sheet (found inside the map (folder/rolled map)) and 

the Project Book cover sheet. Once all information is documented, the technician will then 

create and record a Scan Order Number on the transmittal sheet and proceed to scanning. 

 

BOOK PREPARATION 

1) Receive Project Book(s) from WVDOT with transmittal sheet 

2) Physically move Project Book to a computer workstation to enter transmittal sheet 

information into dbo_Scanning database.  

 

 

Every WV DOT project book scanned by the WVGISTC will have an entry in the WV DOT 

Project Database named dbo_Scanning.  This database provides a means for tracking work 

completed along with published information for the Highway Plans Locator web application 

(www.mapwv.gov/dotplans).   

 

 

GENERATE PROJECT KEY NAME AND CREATE SCAN ORDER # 

1) Open Microsoft Access dbo_Scanning database 

2) Go to the last record in the dbo_Scanning tab  

3) Copy transportation field information from transmittal sheet provided by WV DOT to 

dbo_Scanning table.  This information is used to generate the 23-character (30 characters if 

underscores included) Project Key file name (e.g., B_06_3_0094_00_000_1964_S02115) 

which is used to rename all the files during the QC/File Renaming process needed to 

identify the spfile name of the project book. 

4) Identify Scan Order # from unique ID # field in dbo_Scanning database 

5) Copy tnew Scan Order # to transmittal sheet.  For example, copy Scan Order # 2115 from 

the dbo_Scanning table to the transmital sheets as S02115). 

6) Physically move Project Book to location with other named books  

 

 

The information needed to fill out the field column of the database can be found on the project 

book’s transmittal sheet and/or the cover page.  Copy the key transportation fields for identifying 

the highway book to the dbo_Scanning table.  Most of the information needed to fill out this 
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table (with a few important exceptions described below) can be found on the first page of the 

project book.  This is typically a cover page containing the title, state and federal project 

number, fiscal year, and other information about that project.   

Occasionally pieces of information will be missing from the cover page, such as a title or fiscal 

year.  This information can often be found on other pages within the project book.  If the 

information cannot be found anywhere within the project book, it should be noted in the 

comments field of the dbo_Scanning table.   

Not all project books will have a transmittal sheet, and not all cover pages have all pertinent 

information so the database should be filled out as much as is possible, but there will be times 

when information is missing and columns will remain blank.  Contact Kevin Huffman of WV DOT 

for assistance with missing transmittal information.  

Mandatory columns that MUST be filled out to generate a project key (e.g., (e.g., 

B_06_3_0094_00_000_1964_S02115) are PlanType, CountyID, SignSystemID, RouteNumber, 

SubRoute, BeginMile, and FiscalYear 

 

Table 2:  Data fields of dbo_Scanning database. Boldfaced elements form 30-digit Project Key. 

Field Name Description Notes 

ScanID Unique 6-digit scan order ID 1-digit location (S, D, X) character 
plus 5-digit number  

ProjectTitle Name of the project that the 
plan represents. 

If no title can be found, name the 
project after something relevant, such 
as the county it is in and the route it is 
on. 

FederalProject Federal Project number Not listed on the transmittal sheet. 
Must be found on the physical project 
book (generally in the top right 
corner). 

StateProject State Project number Not listed on the transmittal sheet. 
Must be found on the physical project 
book (generally in the top right 
corner). 

PlanType Must be a letter.  Currently 
permitted values:  R = Right 
of Way, P = Construction 
Plan, B = Bridge, S = Shop 
Drawings, H = 12X18 size 
book 

Corresponds to “Type” field on 
transmittal sheet. 

CountyID Name of county where 
project is located 

Referred to by County ID number on 
transmittal sheet. Check physical 
book for county name (generally in 
the top right corner). 

County2ID Name of second county, if 
project crosses county 
borders 

Not listed on the transmittal sheet. 
Check physical book for county name 
(generally in the top right corner). 

SignSystemID Denotes sign system. Code 
specified by WV DOT.  

Numbers on transmittal sheet 
correspond to a dropdown box in 
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Field Name Description Notes 

Example: 1 = Interstate, 2 = 
US Route, 3 = State, 4 = 
County 

access. If no ID can be found, mark 
as N/A. 

RouteNumber Denotes the project primary 
route number 

Corresponds to transmittal sheet. If 
no route can be found mark as 0.  

SubRoute Denotes the primary sub-
route number 

Corresponds to transmittal sheet. If 
no sub route can be found mark as 0. 

BeginMile Denotes the project’s 
beginning milepost, as stated 
on the project cover/index 
sheet 

Corresponds to the “Begin Milepost” 
field on the transmittal sheet. If no 
begin milepost can be found, mark as 
0. 

FiscalYear Year project was 
commissioned 

If no year can be found mark as 
9999. 

District District in which the county is 
located 

Corresponds to transmittal sheet.  

SpecialCodeID Denotes a special code. This 
code is intended to 
differentiate between multiple 
contracts or projects that fall 
within the same route and 
milepost. Code to be 
specified by WV DOT.  
Example: 01 = contract 1, AA 
= archived set 

Corresponds to “Special Code ID” on 
transmittal sheet. If no ID is listed 
mark as 00. 

ProjectStatus Denotes Project book Status 
ID.  

Corresponds to the “Status ID” field 
on the transmittal sheet. 
1 = initial design, 2 = preliminary 
design, 3 = final design 

BridgeNumbers Denotes relevant bridge 
numbers for the project. 

List all bridge numbers for the project 
book, found in the “Bridge No.” 
section of the transmittal sheet. 

BookLocation Location book was scanned Mark as “Tech Center” 

PublicationStatusID Indicates if book has been 
published on website 

Drop down menu 

ScanDate Date scanned Leave blank 

Scan Count Number of Sheets in book Leave blank 

Comments Comments on project book Add if necessary.  

SupplementalCodeID Denotes a supplementary 
code identifier which refers to 
a key provided by WVDOT 

Mark as “Not Applicable” 

DirectionID Denotes the directional 
heading of the roads depicted 
on the map 

Mark as “Unspecified” 

GeoTIFFSheet The page number used to 
find the georeference.  

Leave blank 

XMax The latitude of the top corner 
used to hold the geotiff in 
correct location on map.  

Leave blank 
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Field Name Description Notes 

XMin The latitude of the bottom 
corner used to hold the 
geotiff in correct location on 
map. 

Leave blank 

YMax The longitude of the top 
corner used to hold the 
geotiff in correct location on 
map. 

Leave blank 

YMin The longitude of the bottom 
corner used to hold the 
geotiff in correct location on 
map. 

Leave blank 

 

(2)  SHEET SCANNING 
 

Each project book will be unbound and each sheet individually scanned, following all best 

scanning practices as determined by WVGISTC staff, the scanner’s user manual, and the 

specifications described below.   

Each page of a project book will be numbered sequentially, and if the page sequencing is 

difficult ot understand, then the page number should be hand-written in pencil in the lower-left 

corner of each page just outside the neat line.  This is to aid WVGISTC technicians and staff 

during the scanning and QC process. 

Double sided scans will have both sides scanned individually, while attempting to remove all 

visible information from the reverse side if possible.  This can be assisted by placing black 

construction paper behind the sheet inside of a protective cover before scanning (black paper is 

located in a cardboard sleeve behind the scanner).    

The document-protection scanning sheath should be used whenever necessary to protect the 

document and/or scanner.  Conditions when this protective sheath should be used include: 

 The document is dirty and might leave dirt in the scanner 

 The document has a waxy coating that may leave residue on the scanner lens 

 The edges of the document are torn. 

 The document is brittle and could be damaged by the scanner. 

 The document is made of a material that is difficult for the sensors in the scanner to 

properly detect, resulting in some scanning errors/inconveniences 

 Any other reason as determined by the scanning technician   

Older sheets tend to need the protective sheath more.  Newer sheets are often made out of 

clean, sturdy materials that don’t require additional protection.   

The scanning software utilized is SmartWorks Pro for both Colortrac SmartLF SC 42e Xpress 

Scanners purchased in summer of 2015. 
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SCANNER SETUP 

 

Turn on the scanner and open SmartWorks Pro scanning software.  Ensure the scanner 

settings are correct. 

 

Scanning Settings 

 

Size 22 x 34 Sheets:  Full Auto Size 
12 x 18 Sheets:  Manual Width with Auto Length 

Width 22 x 34 Sheets:  N/A 
12 x 18 Sheets:  480mm 

Auto BW points Off 

Color Mode 256 Colors with auto palette (8-bit or indexed color) 

Resolution 300 

Quality 1 

Auto Naming Off or Add Numerical Suffix 

Auto Overwrite Type new name if file exists 

File Name S0XXXX-XXXX.tif 

File Type TIFF LZW 

Folder C:\DOT\Imagery\Original Scans\S0XXXX 

 

 

FOLDER, FILE AND PAGE NAMING 

 

Folder Name: On the scanning computer create a folder named after the Scan Order ID for the 

project book being scanned using the computer pathway listed in the above table. 

Scan File Name: The naming convention for individual TIFF digital scans is the Scan Order 

Number followed by the page or sheet number. Example: Sheet number 25 from project book 

S01234 should have a file name of S01234-0025.tif.  For duplicate pages the letters may be 

added after numerals as appropriate (e.g., S01234-0025A) to maintain consistency between 

project book page numbers and TIFF scan page numbers. 

Sheet/Page Naming: Use the Add Numerical Suffix of the scanning software to name the sheets 

(or pages) in sequential order automatically.  When sheets are out of order turn off the auto 

naming feature and manually name the sheets appropriately.  Important Note:  Ensure the page 

number suffix of the digital TIFF image scan corresponds to the page  number of the highway 

plan books  Unfortunately, the scanning software is limited in auto naming pages with 

alphanumeric suffices (e.g., A1, A2, B3) and thus must be manually. 
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PAGE NUMBERING ISSUES  

 

Each scan should have a unique file name based on the sheet number as it appears on the 

physical sheet that was scanned, however sometimes sheets will have identical sheet numbers.  

In these cases, the sheet number will have a 1- or 2-character suffix added to ensure each file 

has a unique name.   

Generally, duplicate page numbers can have various combinations of alphanumeric characters 

(A1, A2, B2, etc.) for the page number suffix to ensure that the individual scan image file names 

adhere to the proper sheet order as the highway plan books.  Example: Two sheets have the 

sheet number 20 written on them.  The first TIFF will be given the sheet number 0020, and the 

second TIFF will be 0020A.  Going further, sometimes there will be a sheet number 20, another 

sheet number 20, a sheet number 20A, and another sheet number 20A.  Thus the sheet pages 

can be numbered as follows: 0020, 0020A1, 0020A2, 0020A3.    It is important that the scan 

file names are in the proper logical order for when the individual TIFF sheets are 

assembled into a PDF book.  Because the SmartWorks Pro Software is not very flexible for 

the auto generation of page number that do not follow a numerical sequence, for project books 

that have page gaps or duplicate pages, the scanning operator must use the scanning software 

to enter the page numbers manually. 

There are a variety of different configurations of page numbers that can be found in WV DOH 

plans.  Besides duplicate numbers other sheet numbering issues that may arise during the 

course of this scanning project include missing numbers, clearly erroneous numbers, 

unreadable numbers, etc.   See the appendix regarding more complex page number issues. All 

issues which are not addressed in this document should be sent to representatives from WV 

DOH. 

  

SCANNING PROCEDURES FOR 12x34 AND 12x18 SHEETS 

1) Select a book from the file-named books area and bring it to the scanner workstation. 

2) Remove clips/tape/staples from sheets 

3) Rearrange pages in proper sequence if necessary.  Add page number suffixes if necessary 

for duplicate pages. 

4) Check that scanner settings are correct.  

5) On the scanning computer create a folder named using the Scan Order Number from the 

transmittal sheets.  Use the computer path name listed in the table above. 

6) Use a “D-size” document protector located in the map case if sheets are dirty, excessively 

waxy or sticky, torn, brittle or any other reason it can’t be scanned like regular sheet 

7) Wipe clean the sheets to protect the scanner and improve the image quality of the scan 

8) Scan sheet 

9) Check image: Make sure it is straight and free of any streaks or artifacts made by the 

scanner 

10) Repeat process until all sheets have been scanned 

11) After the entire book is scanned, the TIFF scans must be moved from the local workstation 

to the IncompleteBooks folder on \\projectsrv\DOTProject\Scanning\IncompleteBooks. 

12) Denote that the physical project book has been scanned by paper or stamp 

13) Move the scanned book to the completed table in the same format (rolled or flat) it arrived.  

file://///projectsrv/DOTProject/Scanning/IncompleteBooks
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14) Record time in Google Performance Tracking and MS Access dbo_ScanningActivity 

  

 

 

SCANNING PROCEDURES FOR 8.5x11 REPORTS 

 

Sometimes 8.5 x 11-inch letter sized reports will be located within certain 12 x 18 books.  These 

8.5 x 11 inch sheets must be scanned using the copier located in room 327 (faculty mail room 

adjacent to the Brooks Hall Administrative Office on the third floor).  

These sheets will be scanned and sent via email automatically, in which the technician will then 

combine the 8.5 x 11 sheets at the end of the 12 x 18 project book PDF.  

Important information 

 Email used: dotscanning@gmail.com 

 Email password: wvgisdot 

 Copier password: 4415 

 

Procedures 

1) Login to the copier using the password (4415).  
2) Press the physical button directly underneath the touch screen labeled “Fax/Scan”. 
3) Select the email address dotscanning@gmail.com. If this email is not present, manually add 

this email into the directory.  
4) Select the “Scan Settings” option near the bottom of the touch screen.  
5) On the Scan Settings screen, several parameters must be set.  
a) Depending on the nature of the sheets, select either single sided or double sided 
b) Change the DPI from 200 x 200 to 300 x 300 DPI for better OCR capabilities when the PDF 

book is don\   
c) Make sure that the PDF format is selected 
6) Exit the scan setting screen and prepare to scan sheets. 
7) Place sheets in the scanning tray, face up, with portrait orientation. Make sure the 

adjustable tray guider is relatively tight against the sheets.  
a) Due to limitations of the copier, it is important to only scan 20 - 30 sheets at a time. 

Otherwise, the copier will experience a paper jam or experience an error with the data 
transfer.  

8) Once the sheets are ready to be scanned, press the large physical green button located 
beneath the touch screen.  

9) The sheets will begin to scan.  
a) If an error occurs, you must restart the process, entering in the specific scan settings 

again. 
b) Try to make sure that none of the sheets are stuck together or building up near the 

output area.  
10) After scanning the entire 8.5 x 11 in. book, return to WVGISTC and go to gmail.com. 
11) Use the email and password for (dotscanning@gmail.com, password: wvgisdot).  
12) The sheets you have scanned should be located at the top of the email list, corresponding to 

the date and time they were scanned.  

mailto:dotscanning@gmail.com
mailto:dotscanning@gmail.com
mailto:dotscanning@gmail.com


12 
 

13) Select the appropriate email and notice that there are multiple different PDF’s that will need 
to be downloaded and combined using the PDF builder Adobe Acrobat. 

14) Download, open, and save each individual PDF to a location that is appropriate (PDF folder 
on the desktop, for example). 

15) Once saved to the computer, select all files and combine into a single PDF.  
a) DO NOT use the PDF builder action on the 8.5 x 11 in sheets. There is no need to 

reduce file size or use the recognize text function. 
16) Make sure that the resulting PDF has the correct number of sheets, while also deleting any 

that may be blank and/or rotating sheets appropriately.  
17) Combine the newly created PDF with the 12 x 14 in. PDF, placing the 8.5 x 11 in. sheets 

after the 12 x 14 in. sheets.  
18) Save this PDF and name it the appropriate book number (Ex. S01354). 
19) Record time in Google Performance Tracking and MS Access dbo_ScanningActivity 

 

 

 

SCANNER CLEANING AND MAINTENANCE  

 

Clean Scanner daily or sooner when necessary and recalibrate scanner when 

necessary/weekly. 

 

The lens should be cleaned with a lint-free cloth and specialized lens-cleaning solution.  The 

white rollers on the lid that sit on top of the sensor when the lid is closed also need to be 

carefully cleaned, and any other dust, hairs, or debris under the scanner lid should be removed.   

Scanned images should be inspected for signs of a dirty lens and/or rollers at the time of 

scanning.  This could include long horizontal streaks on the image, or dots that appear 

repeatedly along a horizontal line, or any number of other markings that appear on the scan but 

are not visible on the physical sheet.   Any scans with excessive visible marks as a result of dirty 

lens/rollers should be rescanned after the scanner is thoroughly cleaned.  

Occasionally, cleaning the scanner lens and rollers will not improve the quality of the scan, 

which will continue to have dark streaks, discoloration, or other issues.  In these cases, it may 

help to recalibrate the scanner.  The scanner’s online manual contains detailed instructions on 

how to perform calibration.  If this also fails to improve conditions, there may be more serious 

maintenance issues that will require a visit from a trained technician.  It will be important to 

carefully monitor the condition of the scanner over the course of this project so that any issues 

can be swiftly handled.   
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SCANNING QUALITY ISSUES 

 

 If images have streaks on them, this means the scanner is dirty.  Delete the image then 

clean the scanner and rescan the sheet. 

 If the scanner is unable to catch a particularly crumpled or frayed sheet either flip the sheet 

before scanning then rotate it with SmartWorks, or place it in a document protector then  

 
SCANNER CLEANING 

 

1) Click in the latches located on the left and right of the base of the scanner to raise the “lid” of 

the scanner, it is recommended the scanner be turned off before cleaning. 

2) Use air duster to remove particulate material by blowing air across the flat bottom surface 

and around support and rubberized rollers 

3) Apply lens cleaner to microfiber rag and gently wipe away dirt from the glass of the scanner. 
Wipe each page cleanly with a disposable microfiber cloth in a downward/consistent 
direction to not spread dirt on sheet. 

4) Use a towel with a small amount of distilled water to clean the rollers of the scanner, if the 

scanner is particularly dirty use Mr. Clean Magic Eraser (use sparingly – micro abrasive 

particles in the eraser slowly degrade the shiny coating on the roller leading to scan image 

artifacts) 

5) Use rubbing alcohol on the glass if persistent streaks on the image scans cannot be 

removed. 

6) Lower lid of the scanner slowly until it clicks back into place. 

 

 

SCANNER CALIBRATION 

1) Open SmartLF Utilities 

2) Retrieve the calibration sheet from the file cabinet 

3) Click the calibration button on screen 

4) Screen will prompt you to insert the calibration sheet into the scanner. Insert the sheet 

exactly as shown 

5) Click calibrate and wait for scanner to perform the calibration 

6) Once calibration is complete click the utilities button 

7) In the utilities window click on the Diagnostics header 

8) Click the Auto Stitch button and wait for the scanner to complete the process 

9) Click Run Diagnostics to double check everything ran correctly. 

10) Close SmartLF Utilities 

11) Open SmartWorks Pro 

12) Scan the calibration sheet and examine the image to check lines are not skewed 
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(3)  IMAGE PROCESSING 

 

Image enhancements are performed on scanned images using Adobe Photoshop software to 

improve image quality.  Image processing tasks include the Auto Contrast and Crop functions 

which are automated using batch processing scripts. 

Auto Contrast adjusts the overall contrast of an image without affecting its color. It is used when 

the image needs more contrast, but the colors look right. Auto Contrast maps the lightest and 

darkest pixels in the image to white and black, which makes highlights appear lighter and 

shadows appear darker. 

It is important when making image enhancement adjustments to ensure no data is lost during 

the process.  For example, if an image is brightened too much, faint or very thin lines may 

vanish.  Conversely, darkening an image too much can cause fine lines or lettering to merge 

together, losing definition.   Each image is different and can withstand different amounts of 

brightening/darkening before losing data.  When in doubt, make no adjustments.   

Scans are cropped in Adobe Photoshop to remove excess white space in the margins and to 

reduce file size.  Technicians should be careful to not crop out any information or markings 

visible on the scan.  When in doubt, do not crop.   

Image enhancement procedures can be performed on the local workstation driver or project 

server.  In addition, the image processing can be expedited using Photoshop macros and 

programs called Actions or Droplets.  Automated programs have been created for both the full- 

size and half-size scan sheets.  Typically, these automated macros or scripts perform 

satisfactorily if the sheets are of similar design and are scanned in a uniform manner.  If the 

cropping script does not crop the image correctly, then the operator can perform a Ctrl-Z to 

undo the action and then manually crop the image.   

Each WVDOT project book scanned will have its own project folder for containing the TIFFs, 

PDFs and GeoTIFFs.  The folder name will be the unique Scan Order ID for that project book, 

which is generated by WVGISTC.   

 

 

IMAGE PROCESSING PROCEDURES 

 

1) Open File Explorer.  

2) Navigate to the IncompleteBooks folder on 

\\projectsrv\DOTProject\Scanning\IncompleteBooks 

3) Open the project book to be image processed 

4) Create a new folder inside the project book folder and name it TIFF 

5) Using Adobe Photoshop software, perform Auto Contrast and Cropping Actions using 

programed actions or droplets on local workstation drive or server. 

a) Example Scripts are located on the project drive 

i) Auto Contrast: ImageContrastAction, ImageContrastDroplet 

ii) Crop:  Crop12x34Action, Crop12X34Droplet, Crop12X18Action, Crop12X18Droplet 

file://///projectsrv/DOTProject/Scanning/IncompleteBooks
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iii) Auto Contrast and Crop:  IP12X34Droplet, IP12X18Droplet 

b) Local Worstation or Server 

i) Local Worksation 

(1) Move all .tif files into the TIFF folder 

(2) Create a local copy of the TIFF folder on your desktop or C: drive 

(3) Drag the TIFF folder on your desktop/C drive into the AutoContrast or AutoLevels 

droplet. 

ii) Server – run image enhancement program on server drive 

6) Record time in Google Performance Tracking and MS Access dbo_ScanningActivity  

 

 

IMAGE SETTINGS AND ENHANCEMENTS 
 

Adjusting the image levels is also useful for eliminating background noise in the whitespace of a 

scan, and for darkening lines slightly.  With proper use of keyboard shortcuts and practice, this 

step can be performed very quickly and may result in much higher image quality.   

This process can be automated for multiple images that require identical, small adjustments. 

Create temporary backup copies of imagery before running any automated processes in case of 

errors.   

Any TIFFs that might be georeferenced later need to be in Indexed color mode and not 

grayscale mode.  Additionally, any GeoTIFFs that may be converted to MrSID format in the 

future need to contain some sort of color in them; not just shades of gray, or else the MrSID 

conversion process automatically converts the image to grayscale, which is incompatible with 

the mosaic.  See the section below on Image Processing for Georeferencing and MrSID 

Conversion for more detailed information.    

Image Qualtiy 
Enhancement 

Settings or Enhancement Tools 

Color Mode Indexed Color Mode (256 colors) 

Auto Image Edits Auto Contrast or Auto Levels  

Cropping Crop actions or droplets (program) 

 

 

 

COLOR MODE 

The color mode or image mode determines how colors combine based on the number of 

channels in a color model. To reduce file size, the color mode of the image should be Index 

Color mode (256 colors). Indexed Color mode produces 8-bit image files with up to 256 colors 

and is enough colors to match the original document.  
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AUTO IMAGE ENHANCEMENTS 

Auto Contrast adjusts the overall contrast and mixture of colors, without introducing or removing 

color casts. Auto Levels automatically corrects the highlights and shadows. 

Auto Contrast simply darkens the darkest pixels to pure black, lightens the lightest pixels to pure 

white, and redistributes all the other tonal values in between. The result is an image with 

improved overall contrast. What's important to note here is that because it treats all three color 

channels as a single composite image, Auto Contrast does not change the colors in the image. 

It simply boosts the overall contrast, making it a good choice for images that don't suffer from 

any sort of color problems and just need a bit more "pop". 

Auto Levels adjusts the overall contrast of an image and may affect its color. If your image 

needs more contrast, and it has a color cast, try this command. Auto Levels works by 

individually mapping the lightest and darkest pixels in each color channel to black and white. 

 

AUTOMATED ACTIONS AND DROPLETS 
 

An action is a series of tasks that you play back on a single file or a batch of files—menu 

commands, panel options, tool actions, and so on. For example, you can create an action that 

changes the size of an image, applies an effect to the image, and then saves the file in the 

desired format. 

Actions can include steps that let you perform tasks that cannot be recorded (for example, using 

a painting tool). Actions can also include modal controls that let you enter values in a dialog box 

while playing an action. 

In Photoshop, actions are the basis for droplets, which are small applications that automatically 

process all files that are dragged onto their icon. 

Photoshop come with predefined actions installed that help you perform common tasks. You 

can use these actions as is, customize them to meet your needs, or create new actions. Actions 

are stored in sets to help you organize them. 

You can record, edit, customize, and batch-process actions, and you can manage groups of 

actions by working with action sets. 

Photoshop has the capability to create "droplets". A droplet is essentially a small application—

external to Photoshop—that is actually attached to the hip to Photoshop. A droplet is created, by 

you, from an action in your actions palette. 

See the Adobe Photoshop online help or YouTube videos for more information on how to create 

actions or droplets for batch file processing.  
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EXAMPLE IMAGE PROCESSING DROPLET CREATION 

 

Create a CropContrast droplet with Photoshop to adjust the margins and brightness of the 

images. Upon completion of the CropContrast Droplet, the technician will be able to drop the 

entire TIFF file into droplet and have it automatically crop and preform autocrontrast on all 

images included in the folder. Once the droplet has completed these processes, the technician 

is to review the edits and make any necessary corrections. The image can be reverted to the 

original format by using the step backwards option under Edit or pressing Ctlr+Alt+Z (may take 

multiple clicks). 

1) Open a tiff image that needs Image Processed in Photoshop 

2) Open the Action window by navigating to the Window dropdown menu and clicking Actions 

3) Create the CropContrast Set 

a. Click the dropdown bar in the Actions window and click create new set. 

b. Name the set CropContrast 

c. Click OK 

4) Create Actions within the CropContrast set 

a. Name CropContrast 

b. Click Record (All processes and tools will be recorded upon clicking) 

c. Crop Action 

i. Select the Magic wand on right hand side tool bar. (fourth one down)  

1. Click inside and close to the neat line surrounding the document.  

2. A dotted line will select the neat line and other document elements 

ii. Click the Select Dropdown menu, highlight modify, and click Expand 

iii. Expand By: 100 pixels. Click OK 

iv. Click Image dropdown menu and click crop 

d. Contrast Action 

i. Click the Select dropdown menu and click All 

ii. Click the Image dropdown menu and click AutoContrast 

e. Click the stop command on the action pane.  

 

 

 

5) Automating the ContrastCrop set 

a. Go to File>Automate>Create Droplet 

b. While in the Create Droplet Window look in the “Save Droplet In” box. Click 

“Choose…” name your droplet “CropContrast” and save it to your desktop. 

6) In the “Play” box’s Set: dropdown box choose the CropContrast and in the Action: dropdown 

box choose CropContrast 

7) Click OK 

Upon completion of the CropContrast Droplet, the technician will be able to drop the entire TIFF 

file into droplet and have it automatically crop and perform autocontrast on all images included 

in the folder. Once the droplet has completed these processes, the technician is to review the 

edits and make any necessary corrections. The image can be reverted to the original format by 

pressing Ctlr+Alt+Z. 
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EXAMPLE IMAGE CROPPING ACTION (HOTKEY) PROCEDURES 

 

The Image Cropping Hotkey Procedure is an alternative approach to cropping the images 

automatically. However, it is advised that this method is used at the technicians own discretion 

because it is sensitive to the alignment of the scanned images. The Hotkey’s Crop Action may 

need to be recreated for each new book. The Auto Contrast image enhancement action can be 

added as a hotkey using these same instructions.  

 

1) Make the Action tab viewable (Window tab>Actions) 

a) The Actions tab can then be docked to the right side of the screen by dragging and         

dropping 

2) Load the Scanning ATN file by clicking on the dropdown menu   in the top right corner 

of the Action tab and select Load Action  

 

3) Load the Scanning ATN file found following this pathway: R:\DOT\ImageProcessing 

 

 

4) Create a new Action by clicking on the dropdown menu corner and select New Action.  

 

5) A New Action dialogue box should appear 

 

a) Name the action Crop 

 

b) Select “Scanning” from the Set dropdown menu 

 

c) Select “F2” from the Function Key dropdown menu 

 

d) Click Record when finished 

 

6) The Crop Action should appear under the Scanning folder in the Action tab  

 

 

 

 

 

a) The action is now being recorded (indicated by the red record button located at the 

bottom   

 

 

 

7) Crop the image to the desired width and height and press enter 

a) Do not save the image yet 
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8) Immediately after hitting enter, click the square “stop” button located at the bottom of the 

action tab 

 

 

9) The Crop action you created can now be used by hitting F2 to automatically crop images to 

the specific width and height that was specified earlier 

a) While the crop hotkey function can be useful, there is a possibility that it won’t crop               

every image to the desired width/height 

b) If this occurs, use Ctrl + z to undo the previous crop 

 

10) To resize the width and height of the hotkey crop, the previous hotkey must be deleted and 

a new hotkey must be created 

a) Select the highlighted Crop option highlighted below (not the Crop option with the F2              

beside it and then click the delete button (highlighted trashcan symbol below) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11) Create a new hotkey by selecting the Crop option with the F2 beside it, hit the record button, 

select the desired width and height, and finish by hitting enter and clicking the stop button 

 

12) Run action set in batch mode from the menu command using File>Automate>Batch… and 

chose the appropriate action set and source/destination folders.  
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(4)  PDF BOOK 
 

After image processing has been completed, the edited TIFFs are compiled into a PDF 

document.  To do this, an automated script created in Adobe Acrobat Pro is executed to reduce 

file size and create OCR recognize text. 

For each WVDOT project book a single PDF document is created that will contain every scan in 

that project book and follows the correct page order.  

 

PDF CREATION PROCEDURES 

1) Open Adobe Acrobat Pro 

2) Make a copy of the TIFF folder you intend to use (you can use the same one on your C 

Drive), DO NOT use the TIFF folder on \\projectsrv 

3) Click on the Action Wizard header on the right side of the window (Tools > Action Wizard) 

4) Click on the created action “DOT PDF”, then click next on the window that pops up 

5) Click Add Files 

6) Navigate to the location where the files you wish to make into a PDF are stored.  Highlight 

all the files you want to combine into a PDF, then click Open 

7) Make sure all files are in the correct order, then click Next 

8) The PDF will then combine and save in your PDF folder on your C Drive 

9) Rename the PDF to match the number of the Project Book, ex S01234 

10) Copy the PDF file folder the particular project book in the “Incomplete” books folder 

\\projectsrv\DOTProject\Scanning\IncompleteBooks 

11) If addition PDFs have to be appended such as 8.5x11 books to 12x18 books, then use the 

Insert Pages Tool in Adobe Acrobat Pro. 

12) Record work in Google Sheet and MS Access dbo_ScanningActivity 

 

 

PDF RESOURCE NOTES 
 

OCR Sheet Rotation:  The automated Recognize Text process involves a step that 

automatically straightens the image by rotating it so that a majority of the text lies perfectly 

horizontally.  This occasionally results in errors, such as the image being rotated to match non-

horizontal text so that the scan now appears crooked, or the image being rotated a full 90 

degrees to match text that appears vertically.  Because of this, each page of the PDF needs to 

be inspected after the Recognize Text tool is run, and any errors corrected.  For slightly crooked 

images, the correction will likely require deleting the erroneous page, converting just that TIFF 

into a reduced-size PDF again, and inserting it into the correct place within the PDF WITHOUT 

running the Recognize Text tool on that page (since that will result in it being crooked again).   

Large PDF File:   If Adobe Acrobat has difficulty creating a single PDF from a large number of 

TIFFs, then break up the process into smaller groups and then combine all the documents.  

file://///projectsrv
file://///projectsrv/DOTProject/Scanning/IncompleteBooks
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ACTION CREATION 

1) Open Adobe Acrobat Pro 

2) Create a New Action 

3) Click on the Action Wizard header on the top right of the window (Tools > Action Wizard) 

4) Click Create New Action 

5) In the “Start with” dropdown menu select Combine Files into a Single PDF 

6) In the left sidebar expand Document Processing and click Reduce File Size 

7) Expand Recognize Text and click Recognize Text (using OCR) 

8) In the “Save to” dropdown menu select “A Folder on my Computer” and make a new                          

folder named PDF 

9) Click Save and name the new action as “PDFbatch” or “DOT PDF” 

10) Existing PDF Action:  (\\projectsrv\DOT\wvDOT_planROW_scanning\Scripts) –

PDFbatch.sequ 

a) Double clicking on the batch action will import it in to Adobe Acrobat if it is not loaded 

 

 

MANUAL PROCEDURES WITHOUT SCRIPT 

1) Open Adobe Acrobat Pro 

2) Select Create 

3) Select Combine Files into a Single PDF 

4) Drag and drop the tiffs into the dialog box, or click Add Files to browse to the location of the 

tiffs to select them.  

5) Arrange them in sequential order, then click Combine Files. This may take a moment. 

6) Save the new file as pdf first, then save it as a Reduced Size pdf using the default settings.  

(Acrobat won’t allow it to be saved as reduced size first). This may also take several 

minutes.   

7) Run the Recognize Text tool:  Tools>Recognize Text>In This File.  Use the default settings.  

This will take another several minutes.  Save again after it finishes.   

 

 

 

  

file://///projectsrv/DOT/wvDOT_planROW_scanning/Scripts
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(5)  GEOREFERENCING HIGHWAY INDEX MAP 
 

Technician will use Photoshop, Google Maps, and ArcGIS to locate and geo-reference each 

project book index map to UTM Zone 17N projection, NAD83 Datum.  The target object to be 

georeferenced is typically found on the first page and is contained in the index map, but it can 

be found in various places throughout the project book. The page that contains the object to be 

georeferenced must be copied from the TIFF folder and then pasted into the GeoTiff folder. 

 

IMAGE FORMATTING FOR MrSID CONVERSION 

 

Some additional image processing steps must be performed to successfully convert GeoTIFFs 

into MrSID file formats.  A Levels Droplet is executed to perform these steps.  The droplet is 

located in this directory:  \\projectsrv\DOT\wvDOT_planROW_scanning\Scripts 

1) Create a GeoTIFF folder on the Local C: drive 

2) Save a copy of the project book’s index page or entire book until you decide which page is 

best suited to Georef into the GeoTIFF folder on the C: drive 

3) Open the TIFF file in Photoshop 

4) Press Ctrl+L to open the Levels window 

5) In the bottom half of the Levels window, increase the left-most value in the Output Levels 
section by 10.   

6) Click OK 

7) Click Image>Mode>RGB Color (you won’t see a change when this happens) 

8) Click Image>Mode>Indexed Color 

9) In the Indexed Color window’s “Forced” dropdown box, click Custom 

10) In the Forced Colors window click the first black box 

11) Check to make sure the R, G, and B values are set to 0 

12) When all these values are set to 0 click OK 

13) Click OK in the Forced Colors and Indexed Colors windows  

14) Save the file as a TIFF (Preset in PhotoShop) 

 

ARCMAP ENVIRONMENT SETUP 

 

1) Open ArcMap 

2) Click the Connect to Folder icon in the Catalog tab of ArcMap (icon is a folder with a + 

symbol)  

3) Connect to the GeoTIFF folder on the C: drive 

4) Also Connect to R:\DOT\wvDOT_planROW_scanning\GeoRef 

5) Drag GeoRef2.mxd into the Table of Contents 

6) Click the Customize header in the ArcMap window 

7) Go to Customize >Toolbars and check Georeferencing 

8) Pin the toolbar to a suitable area   

file://///projectsrv/DOT/wvDOT_planROW_scanning/Scripts
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GEOREFERENCE PROCEDURES 

1) Open GeoRef2.mxd in ArcMap (Found in R:\DOT\wvDOT_planROW_scanning\GeoRef) 

2) Open the processed image you wish to Georef in Photoshop 

3) Drag the tiff into the Table of Contents from the C:\GeoTIFF folder lined to your catalog 

4) A prompt will appear asking if you would like to create pyramids. Click Yes 

 
 

5) A window will appear stating Unknown Spatial Reference. Click OK 

 
 

 

6) Use the image in Photoshop to look for spatial references to match to the image in Arc such 

as roads, rivers, crossroads, etc. (use Google maps to aid you in looking for the area) 
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a) For sheets depicting little to no spatial information, use these clues to aid in 

georeferencing: 

i) A North Arrow will assist in orienting the page correctly (Top left corner of example 

below)The  

ii) For sheets depicting little to no spatial information, use these clues to aid in 

georeferencing: 

(1) Project Title often has additional information corresponding to the location of the 

project, i.e. “Sleeths Run Bridge over Leading Creek” or the limits of the project 

between specific towns i.e. “U.S. Route 48 Bismark – Forman” (Bottom right 

corner of example below).  

(2) Project Title often has additional information corresponding to the location of the 

project, i.e. “Sleeths Run Bridge over Leading Creek” or the limits of the project 

between specific towns i.e. “U.S. Route 48 Bismark – Forman” (Bottom right 

corner of example below).  

 

 

 

(3) The DOT Access database “dbo_Scanning” can also provide additional 

information concerning any routes/subroutes, as well as, begin mileage for 

approximate georeference.  

iii) If the above information is not helpful, georeference the image to the specific county 

and save the file as S0XXXX-0000_UTM17N83.tif (labeling the page number 0000 

specifically) indicating that the project cannot be georeferenced due to limited 

spatial information. Change the GeoTIFF sheet number in Access database to 000 

and leave a comment stating “No Spatial Information”.       
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iv) Another tip for reading DOT book plans. Roads that are dotted are old roads and the 

line with the circles is the proposed plan and should be georeferenced rather than 

the dotted, unless it doesn’t match. 

 

7) Once you have found the area to which you plan to reference the image click the Fit to 

Display button from the Georeferencing dropdown box in the Georeferencing Toolbar. 

 

 
 

 

8) Right click the tiff layer in the Table of Contents and click on properties. 

9) In the Layer Properties window, click the display tab and change the Transparency to ~30% 

10) Click Apply and OK 

11) Use the Rotate, Shift, and Scale buttons  in the Georeferencing Toolbar to match the 

image to the map. 

 

12)  • Once set in place, click the add Control Points button and add control points as 

necessary. Ideally add at least four control points so that a RMS Error number is 

generated. 

 

13) Once finished click the View Link Table button to check and record the RMS Error in the 

Google Sheets Georef sheet.  

 

14) Once set in place, click the add Control Points button and add control points as necessary. 

Ideally add at least four control points so that a RMS Error number is generated.  

 

15) Once finished click the View Link Table button to check and record the RMS Error in the 

Google Sheets Georef sheet.  

16) Now completed, click the Rectify button in the Georeferencing dropdown box.  

a) Set “NoData as:” to 0 

b) Set “Output Location” to the GeoTIFF folder on the local C: drive 

c) Name the file S0XXXX-indexpagenumber_UTM17N83.tif 

d) Set Compression Type to NONE 

e) Click Save 

17) When saved you will find four files that, together, comprise one GeoTIFF file. 

18) Copy all four of these files into a GeoTIFF folder on \\projectsrv\IncompleteBooks\S0#### 

 

file://///projectsrv/IncompleteBooks/S0%23%23%23%23
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19) Go to the Access database and change the GeoTiff column with that book to the correct 

page number of the page that was GeoReferenced. Also leave a comment in the Comment 

column if the plan was particularly difficult to georeference, explaining why the specific 

location was chosen, i.e “Georeferenced to extent of plan on U.S. 48 from Bismarck to 

Forman”. 

 

 

  

20) Record work in Google Performance Tracking Sheet and MS Access dbo_ScanningActivity 
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 (6)  QUALITY CONTROL & FILE RENAMING 
 

 

Due to the complexity in the several previous processes, a special emphasis is placed on 

quality control and assurance to confirm that the technicians are providing the best possible 

product. The technician will check for accuracy and completion of the Database entry, file-name, 

image processing, PDF, and GeoTiff. Upon completion, the technician will use the file renaming 

tool to rename the quality assured folder in the IncompleteBooks folder. Once renamed, it will 

be moved to the Projectbooks folder.  It is recommended that technicians do not Quality Control 

their own work. 

 

QUALITY CONTROL PROCEDURES 

 

1) Navigate to the IncompleteBooks folder on projectsrv and choose a folder to QC 

2) Open the TIFF folder and check that all files are accounted for and have been image 

processed 

3) Open the PDF folder and open any PDF’s within the folder 

4) Check the PDF(s) to make sure the PDF contains the correct amount of pages, all pages 

face the correct direction, and that no pages are askew 

5) Open the GeoTIFF folder and copy all files into your local GeoTIFF folder. 

6) Open GeoRef2.mxd in ArcMap 

7) Drag the TIFF file into the Table of Contents 

8) Right click that layer and click on Zoom To Layer 

9) Check that the Georeferenced index page matches the area to which it is referenced 

10) After confirming that the georeference is correct, highlight the files that comprise the 

GeoTIFF 

11) Right click the highlighted files and click ‘send to’ followed by ‘compressed (zipped) folder’ 

12) Confirm that the files have gone into a zipped folder and then delete the non-zipped files 

13) Check to see if the Access column matches the Georeferenced page to create ease when 

uploading to the website 

14) Record work in Google Performance Tracking Sheet and MS Access dbo_ScanningActivity 

a) Performance Tracking Sheet: Red=fix QC, Green=last check through, White=done, 

Yellow=trouble with something 

b) If during the QA\QC process something has not been done correctly, make a note of it 

and continue the process.  Once the process is complete go back and correct any 

mistakes 
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FILE RENAMING TO PROJECT KEY 
 

1) Open File Explorer 

2) Click the Organize dropdown bar and choose ‘Folder and search options’ 

3) Click the View tab 

4) In the Advanced settings box under Files and Folders check the ‘Always show icons, never 

thumbnails’ box 

5) Under Hidden files and folders check the box ‘Show hidden files, folders, or drives’ 

6) Uncheck the “Hide protected operating system files (Recommended)’ box 

7) A Warning will pop up, click Yes 

8) Click Apply 

9) You will now be able to see the Thumbs icons within various folders.  In order to 

successfully rename a folder you must delete all Thumbs.dbf files from the folder. 

10) Navigate to the projectsrv and find the folder to be renamed 

11) Open the folder and delete the Thumbs from the ProjectBook folder, the TIFF folder, and the 

GeoTIFF folder. (The PDF folder will not contain a Thumbs file)  

12) After deleting all the thumb files, navigate out of the folder to be renamed 

13) Open ArcMap Georef2 there will be a tool bar named DOT File Renaming Tool and 

Microsoft Access: DOT 

14) In Access open the dbo_vw_ProjectKeyLookup 

15) In Arc, click the connect to folder button and connect to 

R:\DOT\wvDOT_planROW_scanning\Scripts 

16) Expand that folder to find FileRename.pyt 

17) Expand FileRename.pyt to find the DOT File Renaming Tool 

18) Open the File Rename Tool and type in the name of the folder to be renamed exactly as it 

appears on the projectsrv in the Old Project Key box of the Rename Tool 

19) Copy the ProjectKey of the folder to be renamed from Access and paste it into the New 

Project Key box of the Rename Tool. 

20) Make sure the ProjectBook Structure box is checked 

21) Run the tool with the Validation only box checked 

22) If there are no issues with the validation, uncheck the box and run the rename tool 

23) After the file has been properly renamed, it must be relocated from the IncompleteBooks 

folder to the ProjectBooks folder (\\projectsrv\DOTProject\Scanning\ProjectBookFolders). 

24) Copy the correctly renamed book in the IncompleteBooks folder and paste it in the 

ProjectBooks folder. 

25) Delete the file from the IncompleteBooks folder. 

 

 

Note:  When running the rename tool, make sure you are outside the folders when in the 

project book. You can be inside the project book but not in TIFF, PDF, or GeoTIFF 

• If there are any issues with the validation, address them and run the validation again 

 

 

file://///projectsrv/DOTProject/Scanning/ProjectBookFolders
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POSSIBLE ISSUES WITH RENAMING: 

 

1) Thumbs in the TIFF folder and GeoTIFF folder.  

2) Error and doesn’t rename Folder but Renames sub folder 

a) Now that the folder has been renamed, copy and paste the folder from IncompleteBooks 

to ProjectBookFolders 

3) File type Suffix on the end of the of the compressed Geotiff folder 

a) Be sure that the compressed zip in the Geotiff folder does not include any suffixes, such 

as .tiff, .zip, .aux, or any other combination. These suffixes lead to error on the website’s 

download geotiff action. 
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(7)  PUBLISHING (includes WEB QC & BACKUPS) 
 

Highway Plans Locator website: www.mapwv.gov/DOTplans 

 

The Highway Plans Locator website is one of the final products achieved in the West Virginia 

Division of Highways Scanning Project. This list details the process, steps, and scripts 

necessary to display the DOH plans on the highway plans locator website 

(www.mapwv.gov/DOTplans.php).  

The files are organized in a geodatabase that houses several image and feature services to 

make data available to the webpage. This section of the Scanning Project Procedures will 

outline the use and function of the scripts and database layers that construct the web map 

service. 

The final process to the WV Division of Highways Plan Scanning Project is uploading the tiffs, 

PDF, and GeoTiffs to the website. First, the PublishGeoTiff.pyt script will run python to copy and 

replace GeoTiff’s into a new folder that will be used to add scan rasters to the mosaic.  Once 

relocated into a new folder and added to the mosaic, the technician will use the 

DOTFootprints.pyt tool to create footprints of the georeferenced image (corners of the image). 

Next, the footprint extents need to be copied into the dbo_Scanning table. This is done with the 

UpdateFootprintextents tool in ArcMap and will automatically update X and Y Min/Max fields in 

the dbo_scanning table. After this tool is finished, the technician must update the 

PublicationStatusID column in dbo_Scanning, which will publish the projectbook to the images 

in the ArcGIS Online Map.  

 

 

DOT GEODATABASE OVERVIEW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mosaic used for 

image service 

Feature class 

containing 

View that is 

published as the 

map service 

http://www.mapwv.gov/DOTplans
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The vw_DOT_Scanning view is used in ArcMap as the layer source for the Footprint map 

service. The DOT database, which stores scanning information and related lookup tables, is 

used on the website to provide this information to the user. 

Since the Map Service and Image Service are fed from a SQL Server enterprise geodatabase 

(dbo_Scanning), it is not necessary to re-publish any services in order to add new scan rasters 

to the ArcGIS Services. All that is needed is to add them to the raster mosaic and update the 

footprint feature class.   

 

PUBLISHING GEOTIFFS 
 

The georeferenced TIFFs from each project book will be combined into raster mosaics in 

ArcGIS for easy viewing.  To add scan rasters to the mosaic they first need to be placed in the 

appropriate folder, this is accomplished using the Publish GeoTIFF python tool in the 

R:\DOT\wvDOT_planROW_scanning\Scripts folder. Expand the tool named 

PublishGeoTIFF.pyt python tool. 

 

 

 

 

 

 

 

 

PublishGeoTIFF.pyt 
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Double-Click DOT GeoTIFF Publishing Tool to open the script, the following box will appear: 

 

 

 

 

 

 

 

 

 

 

 

The Root Folder should be left as: ‘\\projectsrv\DOTProject\Scanning\ProjectBookFolders’ 

The target folder is: ‘\\ExternalDataSrv\GISServiceData\Application\DOT_Planfinder\TIFFS’.  

Click OK and the Tool should run, this will place all the GeoTIFF folder contents from 

\\projectsrv into \\ExternalDataSrv so that they can be added to the Mosaic dataset 

 

 

 

  

file://///projectsrv
file://///ExternalDataSrv
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ADD RASTERS 
 

Next, add the rasters to the mosaic dataset. Right Click the feature dataset DBO_planfinder  

(GDB_DOT.sde\GDB_DOT.DBO.DOT_Planfinder) and select Add > Rasters. If you want to add 

an entire workspace filled with rasters, it is important to use a full UNC pathname so that the 

images can be accessed by the ArcGIS server  

 (\\ExternalDataSrv\GISServiceData\Applications\DOT_Planfinder\TIFFS). Normally when 

adding rasters to the mosaic, the ‘File’ option should be selected in the ‘Input Data’ section of 

the ‘Add Rasters’ dialog. Each raster can be selected individually and added to the ‘Source’ list.  

 

Under the Advanced Options, the Add New Datasets Only (optional) drop down should be set to 

Exclude_Duplicates. Click OK.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If needed, the mosaic can be loaded from scratch by selecting the Workspace option instead of 

Raster dataset under Input Data. The technician must enter the pathname of the TIFF folder. 
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BUILD FOOTPRINTS 
 

When added to a data frame in ArcGIS, each raster mosaic contains three layers, one of which 

is called Footprint.  This is a vector layer of rectangles drawn around the extent of each raster, 

and attributes for each raster are stored here in the attributes table. 

 

So, after the rasters are added to the mosaic dataset, the Footprints of each geo-referenced 

image need to be created. This is done with the python tool (.pyt) DOT Footprint Builder found 

in the toolbox BuildFootprints.pyt in the following folder location 

R:\DOT\wvDOT_planROW_scanning\Scripts. 

 

Open the tool and click OK. The tool should run and finish within 1-5 minutes for <2000 plans. 

 

 

UPDATE FOOTPRINTS 
 

Currently, the footprint layers from each of the mosaics get merged into a single, separate 

Footprints layer and stored in a file geodatabase.  (I think this is referring to the x/y min and max 

stored in dbo_scanning) This provides a single attribute table for every raster in each mosaic, 

making it much easier to search for and view data relating to all the raster’s at once. (The 

projectbook data being accessible on the overview map)  

 

This process will call upon the Projectkey and the SheetNo. ProjectKey will contain the Project 

Key for each raster in the Footprints layer, and SheetNo will contain the sheet number as it 

appears appended to the Project Key in the filename of the raster (including the underscore).  

These two fields are used to create links in ArcGIS.com to our FTP server, and also facilitate 

joining the WV DOT Project Database to the Footprints attributes table.   
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The technician needs to copy the footprint extents into the dbo_Scanning table using the 

UpdateFootprintExtent.pyt toolbox and the associated DOT Footprint Extent Update script. It is 

important to note that the DOT Footprint Extent Update tool will only run on the plans that are 

specified in the Scan Order row, to update all Scan Orders, follow the directions in the tool and 

place a “*” in the Scan Order row. It is also necessary to check the “Update Database” checkbox 

at the bottom of the dialogue box in order to actually update footprint extents. If this box is left 

unchecked then the tool will function as a test and will not copy any information from the image 

service into the database. 

 

Click OK and the tool should populate the xy coordinates in the database. 

 

PUBLICATION STATUS 
 

The raster mosaics and the Footprints layer are currently being published as a GIS service in 

Arc, and then added to a map on the ArcGIS.com map viewer.  This is mostly for demonstration 

purposes, but is also useful as a means of sharing the materials with WVDOT, tracking the 

project’s overall progress, and making it viewable in an interactive environment.  

To publish the service, the user must have access to various server addresses on the 

WVGISTC network, which will likely require admin permission.  The server addresses 

themselves are subject to occasional changes; verify which server the service should be 

published on before proceeding.   

So, the final step is to update the PublicationStatusID column of the Scanning table to ‘2’ or if 

you are using the Access interface open the table and set the PubicationStatus to ‘Published’. 

At this point you should be able to see the new footprints. 

  

Make 

sure to 

check 

this 

box 
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FINAL WEBSITE QC 
 

After the Publication Status is changed to Published, all links on the website should working. 

However, there are a number of different scenarios that cause the links to fail. A final quality 

control is to be completed by the technician who has updated the website.  

1) Navigate to the website: http://mapwv.gov/DOTplans/ 

2) Uncheck the “show first 100 matches only” 

3) Leave all fields blank and click search. 

4) Locate all project books uploaded with last publication.  

5) Click and check each of the four links for each project book.  

6) Note any errors that are found in the QC and refer to the Website troubleshooting for 

information regarding errors.   

7) Make any corrections and continue to Backup procedures. 

 

WEBSITE TROUBLESHOOTING 

 

1) If the PDF works and the Globe does not 

a) Look to see if book is named correctly 

i) Check to see if the book name matches to the dbo_vw_Projectkeylookup 

ii) Check to see if the Georef page number matches the column under dbo_scanning > 

GeoTIFFs (this can only have 3 characters) 

b) A folder issue 

i) Go to the GeoTIFF folder within the problem book and check to see if the zipped file 

folder is within another folder. Removed zipped folder and place it inside GeoTIFF 

folder. 

2) If the PDF does not work and the Globe is not there 

a) Check to see if the Georef page number matches the column under dbo_scanning > 

GeoTIFFs (this can only have 3 characters) 

3) If the download tiffs (scenic portrait button) does not work 

a) Check geotiff file-pathname. Make sure that the folder does not include the ending 

“.aux.zip” 

4) If footprints display but raster mosaic does not appear: 

a) Clear TIFFs folder on externaldatasrv and remove rasters from GDB_DOT.sde 

b) Complete the Website Upload Procedures. 

Important: To get rid of duplicate book numbers when uploading to the website go to the 

externaldatasrv and delete the folder tiffs. When adding rasters, go to advanced settings in the 

dialog box and check “exclude duplicates”. 

Record work in Google Performance Tracking Sheet and MS Access dbo_ScanningActivity  

 

 

 

http://mapwv.gov/DOTplans/
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BACKUP PROCEDURES  
 

EXTERNAL DRIVE 

The external drive is to be backed up weekly by one technician at the end of the work week. 

After being backed up, a transmittal sheet should be updated and saved to the external drive 

DOT Scanning folder, which records the date of backup, project books included, and the 

amount of storage used. The transmittal sheet can be found on the external drive being used to 

back up the scan data.  

Automatic Backups are now being conducted daily, with the SyncBack program installed on the 

“Preston” computer. The “DOT Scanning Auto” schedule is set to run at 1:00am every night and 

copies all project books onto the DOT Backup A folder. As these are updated daily, it is 

important to remember to update the transmittal sheet weekly.  

 

 

INTERNAL SERVERS 

The internal backup server is to be updated at the conclusion of the final website quality control 

to insure that all edits are contained in the back up.  The technician completing this quality 

control will copy all published project books from the ProjectBooks folder to the DOTBackup 

(\\projectsrv\DOTBackup) (This location will change when we identify another server to store our 

back up).  

DIGITAL PLAN PROCEDURES 
 

 

In the event of digital plan submissions of previously scanned images from WV DOH District 

offices, technicians will follow the procedures as outlined below. This methodology is subject to 

change as digital plan submission formats and procedures change.  The following work tasks 

may be affected by digital submissions: 

 

 File Naming 

 Image Processing 

 PDF Creation 

 Georeference Plan Index Map Sheets 

 Quality Control/Quality Assurance 

 Publishing Web Map 

  

file://///projectsrv/DOTBackup
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APPENDIX A:  Page Number FAQ 
 

Page Numbering FAQ 

The following Q&A’s are examples of page numbering questions/inconsistencies that have 

arisen during the course of the scanning project.  New questions are added to the document as 

problems are discovered, and answers are added as they are received.   

 

Q: Duplicate pages exist within a bundle, except one has a stamp, signature, or some 

other small difference, though no official revision.   

A: Only scan the page with additional content, no need to scan old one.  

 

Q: Pages are arranged out of order. 

A: Rearrange the pages by the official page number as seen on the sheet.  If there are pages 

from different projects within the same book which are numbered by a different 

system/sequence, retain the order in which those pages were physically found when creating 

the PDF document, as they were likely placed in that order intentionally by WV DOT.   

 

Q: Two pages with different content, but same page number. 

A:  They might be from different projects.  If so, retain the order in which they were found, 

keeping the same file name and adding a letter after the page number (starting with A) for every 

sheet with the repeating page number.  Make a note in the project database; be sure to specify 

which project the page in question is from if it is from a different project.   

There is also a chance the pages were miss-numbered.  Example: 17, 18, 20, 20…  In a case 

like that, correct the page numbers in the file name (in the example, you would change the first 

20 into 19), retaining the order in which the pages were found.  

 

Q: Some pages are marked as deleted with a large X crossing the entire page and text 

that reads “This sheet deleted, see page 81A” or the like.  In this example, there was a 

page 81, then another page 81 that was marked as deleted and referred to page 81A.  

A: The deleted page does not need to be scanned (according to WVDOT), though it may be 

wise to scan it anyway and add an “X” suffix to the page number.  Make a note of it in the 

database either way.   

 

 

Q: Some sheets have no visible page number.     
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A: Give them one for now, according to the sequence in which they were discovered.  If the 

previous page was 0017, name the ones without a number 0017A, 0017B, etc.  Keep them in 

the order they were discovered when creating the PDF document.  Make a note in the 

comments field of the database describing how they were numbered.  

  

Q: One project book can contain sheets from multiple projects.  EXAMPLE: Project 32, 

starting on the second page it switches to a different project in a different county for 37 

pages before switching back to the original project listed on the cover sheet, beginning 

with page #2.  Another EXAMPLE: Project 17 has two pages appended to the end from 

unrelated projects.  Another EXAMPLE: Project 33 , page 52 (there are two of them) is a 

seemingly random page from some unrelated project.  How should we handle examples 

like these?  Separate them?  Keep them in the same folder and number them as they 

appear?   

A: Those pages were usually put in there by WV DOT staff for a reason, so be sure they are 

arranged in the PDF as they were discovered.  As for naming the TIFFs, they are permitted to 

have an entirely different key based on the project they come from and still remain inside the 

project folder in which they were found.  This will arrange the files out of sequence in the TIFFs 

folder, but it will be ok as long as the correct order is maintained in the PDF, and a descriptive 

note is written in the comments field of the database.  HOWEVER, Kevin Huffman said he’ll get 

back to us with a better solution to this issue.   

 

Q: Pages repeat, but with some revisions.  

A: The original un-revised page does not need to be scanned (according to WVDOT), and the 

revised page should get the original page number.  It may be wise to scan the un-revised page 

anyway and give it a unique page number (add a letter to the page number) that should be 

noted in the comments field of the database.  In some cases the revised page has a unique 

page number already visible on the sheet, usually just adding a letter to the sheet number.  If 

so, use those numbers in the file name.   

 

Q:  The 25th project we scanned was the second part of the 32nd project we scanned.  

Shall we put them both in the same folder and make one PDF out of them? Or keep them 

separated as they are physically and give them different names?  

A: Combine them.  Make a note in the comments field describing which pages were found 

physically separated.   

 

Q:  An “addendum” sheet was discovered within a project.  It is much smaller than the 

other sheets, and has no page number aside from “Addendum B” or some such.   

A: Scan it and give it the page number ADDN, and add an additional letter to the page number 

as necessary if there is more than one ADDN, or if the page says something like “Addendum B” 

as in the example above.   



40 
 

 

Q: Project 37 is the soil profile for project 36, but has a different fiscal year and pages 

number 1-20. Keep separate, or combine files into one folder?  

A: Combine them, giving the files different names within the folder to reflect the difference in 

fiscal year, and make a note in the database.   

 

Q: One project contains copies of sheets from a different project that has already been 

scanned. Example: Project 33 contains copies of pages 52-54 from project 30; they were 

placed in project 33 next to the pages of the same number. How should they be 

numbered?  Should they be scanned at all, since that would be effectively doing the 

same work twice?  Or is there likely a good reason for them to be there and so they 

should be treated as part of that project? 
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APPENDIX B:  Image Processing Checklist 
 

1. Import Image Processing into Photoshop 

a) Open the Actions window 

i. Window>Actions 

ii. Or shortcut Alt+F9 

b) Click the drop down menu located in upper right corner. Click “Load Actions…” 

iii. Retrieve Actions from the following folder: 

R:\userFiles\Sarah\DOT\IP\Scanning  

c) Automate image processing for entire folder of scans 

i. File<Automate<Batch 

ii. Action: Select “IP” 

iii. Press choose button and browse for folder of scans you want to image 

process 

iv. Press choose button and browse for folder to which you want finished scans 

saved, the IP folder within the project book folder 

2. Import TIFFs into Photoshop (PS) 

a) Open correct folder with scanned TIFFs in windows explorer 

b) Change view of TIF files to Large Icons using drop-down in upper right corner 

c) Select first row of images and press enter 

3. CROP 

a) In PS use crop tool to crop along all edges of scan to remove excess white space 

b) DO NOT crop any writing or printed info along borders of scan 

c) If sheet was scanned slanted, then some white space will show after being cropped 

d) Ctrl+z will undo any crop you make but will only work once (try it twice and you’ll see 

what happens) 

e) Take Advantage of Crop Shortcut 

i. Create new action named “Crop” (create function key if desired) 

ii. Crop first sheet like normal and press stop button. 

iii. Select next scan and either press play button or function key and the scan will 

automatically crop to specifications you recorded in previous scan 

4. This shortcut only works well if all scans are scanned aligned with the same reference 

line on scanner. Otherwise you will have to delete and record new crop dimensions 

constantly to a point where it’s no longer a shortcut. 

                  

5. Save-n-Close Each Tab   (Ctrl+s; Ctrl+w) 

NOTE: Check to see if every scan has been processed correctly row by row in scan 

folder. Do this by looking for any scan that hasn’t been cropped via large icons. PS has 

tendency to not import every scan you select so always check.  
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APPENDIX C:  Planfinder Python Scripts Documentation 
 

The DOT Project Plan Scanning system is designed around an operational database used 

for recording scanning activity and an enterprise geodatabase used to support web mapping and 

image services. The system takes advantage of the multi-user capability of Microsoft SQL Server 

2012, allowing scanning information to be recorded in real-time and new scans to be published 

as they are created. Detailed information is recorded related to each step of the scanning process 

so that production performance can be monitored and metrics can be established for scheduling 

and cost analysis. In addition, the use of an enterprise geodatabase streamlines the process of 

updating the ArcGIS feature and image services by eliminating the need to re-publish an entire 

ArcGIS geodatabase in order for updates to be made available on the web. 

The ArcMap project used for feature and image service publication is named DOT.mxd. 

This project defines the related feature classes, raster mosaic, and database tables. It also 

defines the standard symbology and related database connection information. This ArcMap 

project is stored on a production file server in the WV GIS Technical Center and is backed up on 

automated schedule (Figure 1). 

 
Figure 1: ArcMap / ArcCatalog Listing of the Arc Project and related toolbox items 

 

The supporting ArcGIS enterprise geodatabase contains three primary objects: 1) a raster 

mosaic used as the source for the ArcGIS image service, 2) a feature class representing map foot 

prints of each scanned construction plan, and 3) a database view that is used as the underlying 

source for the published plans and for the web based query interface.  These can be seen in the 

following screenshot taken from the ArcMap Catalog interface (Figure 2). 
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Figure 2: DOT enterprise geodatabase structure. 

 

 

The vw_DOT_Planfinder view is used in ArcMap as the layer source for the Footprint map 

service.  This view links the ArcGIS feature class inform to the operational scanning data. The 

view is defined as follows: 

 

 

 
Figure 3: Feature service symbology and ArcGIS hosted services  

Mosaic used for 

image service 

Feature class 

containing footprints 

View that is published 

as the map service 

vw_DOT_Planfinder view definition in ArcMap: 

CREATE VIEW vw_DOT_Planfinder AS  

  SELECT OBJECTID 

  ,Name 

       ,[Shape]  

  , Scanning.* 

   FROM GDB_DOT.dbo.DOT_Planfinder_Footprint 

    JOIN DOT.dbo.vw_Scanning AS Scanning  

   ON  Scanning.ScanOrder = 

DOT_Planfinder_Footprint.ScanOrder 
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The structure of the DOT database used to store scanning information and related lookup 

tables can be viewed from within ArcMap or Arc Catalog. All administration for this database is 

performed using Microsoft SQL Server Management Studio. Backup plans are defined from within 

the management interface and scheduled backups are run using the SQL Server Agent process. 

 
Figure 4: DOT Database table listing 
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Since the Map Service and Image Service are fed from a SQL Server enterprise 

geodatabase, it is not necessary to re-publish any ArcGIS services in order to add new scan 

rasters. All that is needed is to add the new images to the raster mosaic and update the footprint 

feature class.  To add scan rasters to the mosaic they first need to be placed in the folder 

‘\\ExternalDatasrv\GISServiceData\Application\DOT_Planfinder\TIFFS’. This is accomplished 

using the Python tool “PublishGeoTIFF.pyt”. This tool extracts the GeoTIFFs from the zipped 

versions in the individual project book folders that are created during the scanning process. 

These zipped images are located under 

“\\projectsrv\DOTProject\Scanning\ProjectBookFolders”. The tool can process a single project 

book folder or optionally all folders. If a Project Key value is specified, then only the 

corresponding GeoTIFF will be published. If the Project Key value is left blank, then the 

GeoTIFF files for all projects will be extracted to the production folder. 

 
Figure 5: PublishGeoTIFF.pyt  user interface  
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It is important to use a full UNC pathname so that the images can be accessed by the ArcGIS 

server. Normally when adding rasters to the mosaic, the ‘File’ option should be selected in the 

‘Input Data’ section of the ‘Add Rasters’ dialog. Each raster can be selected individually and 

added to the ‘Source’ list.  

 

If needed, the mosaic can be loaded from scratch by selecting the Workspace option as shown 

below and entering the pathname of the TIFF folder. 
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Once the new rasters have been added to the mosic, their footprints are built using the 

Python tool “BuildFooprints.pyt”. This tool removes all existing footprints then rebuilds the feature 

class by scanning the rasters and generating new features. The default location for the raster data 

is “GDB_DOT.sde\GDB_DOT.DBO.AMD_DOT_Planfinder_CAT” and the target footprint feature 

class is “GDB_DOT.sde\GDB_DOT.DBO.DOT_Planfinder_Footprint”. 

 
Figure 6: PublishGeoTIFF.pyt  user interface 

 

At this point, the footprints and images for all scanning table entries that have their Publication 

Status set appropriately will be searchable in the web query interface and visible in the ArcGIS 

Online map. 
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APPENDIX D:  Entering a New Book into the Access Database 
 

Before a book can be scanned its information needs to be entered into the DOT Access 

database. The Access file can be found in R:\DOT\wvDOT_planROW_scanning\DOT.accdb.  

 

First, gather the transmittal sheet that is rolled inside of the new book. Leave the book open, as 

there is some information that will need to be retrieved from the sheets.  

 

Open DOT.accdb and click on dbo_Scanning under 

Tables on the left hand side. 

 

This is where you will enter the information from the 

transmittal sheet. 

 

If necessary right click the “ID” column and click sort 

by smallest to largest. Scroll to the last record (or hit 

skip to last record at the bottom). The “ID” column 

corresponds with the “S00000” number assigned to 

every book. The new book you are entering in will 

always be the next number in order. 

 

Write this number in the top right section of the 

transmittal sheet, labeled “Scan Order Number.” 

 

Now we will begin filling in the columns for this entry. 

Each column corresponds with information either on 

the transmittal sheet or the plan sheet itself (some 

columns are left blank until a later time). 

 

In the following pictures I have illustrated for you 

where the information for each column in the database 

can be found in the transmittal sheet or the plans. (I have minimized the columns you will not be 

entering the information in for at this time). Each large bold number I have placed on the 

database matches the corresponding information on the transmittal and plans: 
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Most of these are self-explanatory, some require more explaining: 

 1 or “ID” – you do not have to type the ID number in, it will be automatically 

recorded 

 6 or “County2ID” – this would be used if the plans went through two counties 

 8 or “Sign SystemID” – corresponds like so: 

o 0 = Municipal Non-State 

o 1 = Interstate 

o 2 = U.S. Highway 

o 3 = WV State Route 

o 4 = County Route 

o 5 = N/A 

o 6 = State Parks and Forest 

o 7 = FANS 

o 8 = HARP 

o 9 = US Forest Road 

o 10 = WV State Rail Authority 

o 11 = Trails 

o 12 = Other 

 13 or “BookLocation” – refers to the physical location of the book at this time 

 14 or “Coments” – extra information, often not needed 

 15 or “SupplementalCodeID” – if this is 0 on the transmittal sheet select “Not 

Applicable” on the database 

 16 or “DirectionID” – if this is 0 on the transmittal sheet select “Unspecified” 

 18 or “ProjectStatusID” –  

o 1 = Initial Design 

o 2 = Preliminary Design 

o 3 = Final Design 

 20 or “BridgeNumbers” – enter bridge # listed on the transmittal sheet, if there 

are multiple bridge #s separate them with commas. 
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*If you enter a mistake/typo the “Esc” 

key will exit the row and you may 

start over.* 

After you have completed entering 

all the information, you are ready to 

print the scanning form. Click on 

ScanningForm under Reports and 

enter the scan order number you 

would like to print. 

 

A scanning form will be generated, 

along with the project key. Print the 

form, roll up the book and attach the 

form to the outside. 
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APPENDIX E:  Procedures Outline 
 

7/29/2016 

1) Book Preparation & File Naming 

a) Receive Project Book(s) from WVDOT  

i) Transmittal sheet provided by WV DOT 

(1) Denote if plan is located in ProjectWise 

ii) Project Key provided by WVDOT 

iii) Scan Order # designated by WVGISTC 

iv) Remove clips/tape/staples from sheets 

v) Rearrange pages in proper sequence if necessary. 

vi) Review page number suffixes 

vii) Enter Project Book information into dbo_Scanning sheet in MS Access 

viii) Information found on Project Book cover sheet 

ix) Project Key found on transmittal sheet 

x) Create project folder on scanning machines to contain scanned images: 

xi) Name project folder with Scan Order #  

 

File Naming 

b) File Naming 

i) Designate Scan Order # on Project Key/Transmittal Sheet 

ii) Pull information from Project Key/Transmittal Sheet and Book to add to the DOT 

Scanning Database 

(1) Includes: 

(a) Processing Status 

(b) Publication Status 

(c) Project Title 

(d) Federal Project 

(e) State Project 

(f) County ID 

(g) County 2 ID 

(h) District 

(i) Sign System ID 

(j) Route Number 

(k) Sub Route Number 

(l) Fiscal Year 

(m) Sheet Count 

(n) Plan Type 

(o) Scan Date 

(p) Book Location 

(q) Comments 

(r) Supplemental Code ID 
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(s) Direction ID 

(t) Begin Mile 

(u) Project Status 

(v) Special Code ID 

(w) Special ID 

(x) Bridge Number 

(y) URN (Uniform Resource Name) for ProjectWISE 

 

2) Scan Document 

a) Scanner Settings: 

i) Size – Full auto size 
ii) Auto BW points – Off 
iii) Color Mode – 256 Colors – auto palette 
iv) Resolution – 300 
v) Quality – 1 
vi) File type – TIFF LZW 
vii) Folder – C:\DOT\Imagery\Original Scans\ScanOrder# 

(1) 22x34 = S00000 
(2) 12x18 = S00000 

(a) Change Settings to Manual Width (480) Auto Length 
(3) 8.5x11 = S00000b 

b) Configure scanner with Scan Order #, page number, and output location  

i) Files are named by the DOH established naming convention 

(1) ScanOrder-PageNumber.TIF 

(2) Verify page number accuracy 

(3) Save scans in folder named with Scan Order #/TIFF 

c) Scan sheets 

i) Wipe each page cleanly with a disposable microfiber cloth in a downward/consistent 
direction to not spread dirt on sheet 

ii) Check each page for number changes or additional suffixes (generally letters) 
iii) Use the document protector in a case of sheets being dirty, excessively waxy or 

sticky, torn, brittle or any other reason it can’t be scanned like regular sheet  
d) Scanner Maintenance:  Clean Scanner daily or sooner when necessary and recalibrate 

scanner when necessary/weekly 

e) Re-bind\replace all sheets as it was received 

f) Roll sheets and fasten with rubber band 

i) Place transmittal sheet inside roll 

ii) Add colored paper with scan order number to outside of roll 

g) Update dbo_ScanningActivity Tracking Database in MS Access: 

i) Book Number 

ii) Date of Action 

iii) Technician performing action 

iv) Action taken 

v) Time worked on Action (minutes) 

vi) Quantity completed (sheets) 

vii) Sheet Count (finished book) 
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viii) Scan Count (finished book) 

ix) Additional Comments 

h) Complete this process after every completed action or before the end of shift 

i) Project Book is now ready to return to WVDOT 

 

3) Image processing  

a) Create Photoshop droplets for image adjustment and crop automation 

b) Image Process project book folders 

i) Save a copy of the incomplete book onto desktop with file name “TIFF” 

ii) Drag “TIFF” through droplets 

ii) Check each image and crop by hand when necessary 

 

4) PDF Creation 

a) Create an action in Adobe Acrobat Pro 

Action Procedure:  

i) Reduce File Size 

ii) Run Recognize Text (using OCR) Tool 

ii) Name action “DOT PDF” 

b) Run action “DOT PDF” 

c) Check PDF for rotation errors resulting from Text Recognition tool and make necessary 

corrections. 

i)  Every page that has an error needs to be corrected individually without using the Text 

Recognition Tool by: 

    A)  Creating a new, single page PDF 

    B)  Reduce file size 

    C)  Save PDF 

    D)  Replace original page with the corrected page from the new PDF 

d) Save in ProjectBookFolder/PDF 

i) Naming Convention: ProjectKey.pdf  

 

5) Georeference Plan Index Map Sheets 

a) Estimate 1 map sheet per project book (cover sheet) 

b) Prepare TIFF for geo-referencing 

i) Save a copy of TIFF to a “GEOTIFF” folder on local drive for georeferencing  

ii) Crop out all whitespace/margin  

iii) Adjust image format for Web Map Index compatibility 

(1) Must be in 8-bit, Indexed Color mode 

(2) Brighten TIFF if necessary (no pixels below RGB=’10,10,10’) 

(3) Create custom color index with index value ‘0’ set to black (RGB=’0,0,0’) 

iv) If converting to MrSID format: 

(1) Adjust color levels to add minor color data to TIFF if necessary 

c) Georeference TIFF 

i) When rectifying, set NoData as ‘0’ to set background transparency 

d) Name georeferenced images according to DOT naming conventions 
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i) Naming conventions: ProjectKey_PageNumber_UTM17N83.tif 

ii) Save in local “GEOTIFF” folder 

iii) Paste in: ProjectBookFolder/ProjectKey/GeoTIFF 

e) Update Tracking Database’s Georeferencing sheet 

i) Scan order number 

ii) Page number 

iii) Amount of time to georeference 

iv) RMS error 

v) Technician initials 

vi) Date 

vii) Additional notes 

f) Enter information into dbo_ScanningActivity sheet in MS Access 

 

6) Quality Control/Quality Assurance: Procedures for each Project Book  

a) Accuracy/completion of Project Database entry.  

b) File-name accuracy 

c) Completion/quality of image processing 

d) Completion/accuracy/quality of PDF 

e) Completion/accuracy of GeoTIFF 

f) File renaming and editing with FileRename.pyt  

i) Subfolders: 

(1) TIFF 

(2) PDF 

(3) GeoTIFF 

g) Update Tracking Database’s QC Checklist sheet (for beginners) 

h) Back-up all files onto project server FTP drive and external drive (limited personnel) 

i) Update Plan location in dbo_Scanning via MS Access 

 

7) Publishing Web Map 

a) PublishGeoTIFF.pyt run python tool to copy and replace GeoTIFFs 

b) Add rasters to Mosaic Dataset 

c) Attributes 

i) Esri GIS attributes automatically created in DOT.mxd file 

ii) Pre-defined attributes in raster mosaic image-service 

(1) PDF link 

(2) Link to Project folder for access to all related files 

(3) Link to zipped GeoTIFF download 

d) Execute scripts to update Web Application query and Map 

i) Publish GeoTIFFs Procedure: PublishGeoTIFFs.pyt 

ii) Add Rasters to Mosaic Footprint creation: BuildFootprints.pyt 

iii) Update Footprints in dbo_Scanning MS Access: UpdateFootprints.pyt 

e) Switch PublicationStatus field in dbo_Scanning to Published  

f) All uploaded plans should appear on the web application 

<mapwv.gov/dotplans/index.php> 
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g) Digital Plan Submission 

i) In the event of digital plan submissions of previously scanned images from WV DOH 

District offices, technicians will follow the procedures as outlined below. This 

methodology is subject to change as digital plan submission formats and procedures 

change. 

(1) File Naming 

(2) Image Processing 

(3) PDF Creation 

(4) Georeference Plan Index Map Sheets 

(5) Quality Control/Quality Assurance 

(6) Publishing Web Map 

h) Final Website Quality Control 

(1) Locate all project books uploaded in the last publication.  

(2) Click and check each of the four links for each project book.  

(3) Note any errors that are found in the QC and refer to the Website troubleshooting 

for information regarding errors.   

(4) Make any corrections and continue to Backup procedures. 

i) Back Up Procedures 

(1) External Drive (Weekly) limited access 

(a) Select new Projectbooks from the R: drive 

(b) Copy and Paste books to WVDOT_Scans_B 

(c) Update Transmittal 

(2) Internal Servers (conclusion of website QC) 

(a) Select all projectbooks 

(3) Copy and paste into \\projectsrv\BACKUP.  

 

Major Procedural Tasks associated with Hardware, Software, Management Documents 

Processing Task Hardware Software Management Documents 

Book Preparation 
& File Naming 

Scanning 
Computers 

File Explorer  dbo_scanning 

Scan Document Scanning 
Computers 

 GS_performance_tracking 
 dbo_scanningActivity 

Image Processing Local 
Workstations 

Adobe PhotoShop  
PDFbatch.sequ 
AutoCrop.atn 

GS_performance_tracking 
dbo_scanningActivity 
dbo_scanning 

GeoReference Local Workstation 
ProjectSrv 

ArcGIS 
Google Maps 

GS_performance_tracking 
dbo_scanningActivity 

QA/QC Local Workstation 
External Drive 
ProjectSrv 
External Server 

FileRename.pyt 
 

GS_performance_tracking 
dbo_scanningActivity 
dbo_scanning 
 

Publishing & Web 
QC 

 

 PublishGeoTIFF.pyt 
BuildFootprints.pyt 
UpdateFootprints.pyt 
 
 

dbo_scanning 
dbo_scanningActivity 

 

file://///projectsrv
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APPENDIX F:  Transmittal Sheet 
 

Project Key Project Title: 

 

 

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17  18 19 20 21 22 23 

 
            

 
   

 
     

 

 T
y
p
e
 

 C
o

u
n

ty
 ID

 

 S
ig

n
 S

y
s
te

m
 

Route Number 
Sub 

Route  
Begin Milepost 

 

Fiscal Year 

 
Scan Order Number 

 

S- Scanned at WVGIS TC 

D- Digitally Received by District 

(To be completed by scan tech.) 

1 4 5 6 7 8 

_ _ _ _ _ _ 

D
is

tric
t #

 

Special 

ID 

Status 

ID 

Supplemental 

Code 

9 

Bar # 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

Bridge #  

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
. 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
. 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
_ 

 
. 

 
_ 

Notes: ProjectWise:     Y   /   N 

Supplemental 

Information 


